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This is a summary of tips and how-to for special operations to be carried out with the computer code 
FLIGHT-X. This report is normally updated when there are updates to the software. For information, 
please contact the author. 
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FLIGHT User-Inputs 
 
LOAD AIRPLANE MODEL 

• Turbofan [24 families] 
o Airbus A300-600 (GE CF6 engines) 
o Airbus A319-100 (CFM56 engines) 
o Airbus A320-Series 

 CFM56 engines 
 IAE V2527 engines 
 NEO (GE Leap 1A engines) 

o Airbus A321-200 (CFM56 engines) 
o Airbus A330 Series  

 -200 (CF6 engines) 
 -240 (Rolls-Royce Trent 772 engines) 
 -300 (CF6 engines) 
 -340 (Rolls-Royce Trent 768 engines) 
 -900 (neo, Rolls-Royce Trent 7000-72 engines) 
 -743 (XL, Beluga, Rolls-Royce Trent 772 engines) → also Cargo/Freighter 

o Airbus A340 Series 
 -200 (CFM56 engines) 
 -300 (CFM56 engines) 
 -500 (Rolls-Royce Trent 553 engines) 
 -600 (Rolls-Royce Trent 553 engines) 

o Airbus A350 Series 
 -900 (Trent XWB_075 engines) 
 -1000 (Trent XWB_084 engines) 

o Airbus A380 Series 
 -861 (GP 7270 engines) 
 -841 (Rolls-Royce Trent 970 engines) 

o Boeing B737 Series 
 -700     
 -700W 
 -800      
 -800W  
 -900W  
 -MAX8 (LEAP-1B25 engines) 

o Boeing B757-200 (PW engines) 
o Boeing B767 Series 

 -300      (CF6 engines) 
 -300ER (CF6 engines) 
 -300ERF (CF6 engines) → also cargo/freighter 

o Boeing B777 Series 
 -200      (GE engines) 
 -300      (GE engines) 
 -300ER  (GE engines) 
 -200IGW (GE engines) 

o Boeing B747 (all) 
 -400 (CF6 engines) 
 -400F (CF6 engines) → also cargo/freighter 
 -800 (GEnx engines) 
 -100-SCA (with Space Shuttle Orbiter, coupled/decoupled) 
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o Boeing B787 Series 
 -800 (Trent 1000 engines) 
 -900 (GEnx-1B engines) 

o Bombardier CS series 
  CS300 

o Bombardier Regional Jet 
 CRJ900 (CF34-8C5A1 engines) 
 CRJ700 (CF34-8CAB1 engines) 

o Cessna Citation Latitude (PW306 engines) 
o Embraer ERJ Series 

 -170      (CF34 engines) 
 -175      (CF34 engines) 
 -190      (CF34 engines) 
 -195      (CF34 engines) 
 -145      (AE3007 engines) 
 -145XR (AE3007 engines) 

o Gulfstream G550 (BR7 engines) 
o Dassault Falcon 2000  

 (no winglets) 
 -S/LX (PW308C engines) 

o BAe Systems (Avro) 146 
 Series 200, RJ85 (Lycoming LF507-1F engines) 
 Series 300, RJ100 (Lycoming LF507-1F engines) 

o Ilyushin Il-76TD (D-30KP engines) 
o Lockheed U-2S (F118-GE-101 engines) 

• Turboprop [11 families] 
o Bombardier Dash8-Q400 (PW150 engines) 
o ATR72-500 & -600 (PW127 engines) 
o ATR42-500 (PW127 engines) 
o Airbus A400M (TP400 engines) → also cargo/freighter 
o Airbus/CASA CN295 (PW127 engines) 
o Lockheed Hercules C130J → also cargo/freighter 

 Conventional 
 With external fuel tanks 

o Beechcraft B350i (King Air) 
o General Atomic MQ-9, Reaper, (TPE-331 engines) 
o Pilatus PC-12 
o SAAB 340B (CT7-9 engines) 

 (cargo version) → see cargo/freighter 
o Cessna C208 Series 

 -B Standard 
 Floatplane 
 Super Cargo Master (→ see cargo/freighter) 

• Cargo/Freighter [19] 
o Airbus A300-600F (CF6 engines) 
o Airbus A330-200F (RR Trent 768 engines) 
o Airbus A330-743 (XL, Beluga, Trent 772 engines) 
o Boeing B757-200PF (PW engines) 
o Boeing B767-300ERF (CF6 engines) 
o Boeing B777-F (GE engines) 
o Boeing B747-400F (CF6 engines) 
o Boeing B747-800F (GE engines) 
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o ATR72-600F (PW engines) 
o Airbus A400M → also turboprops 
o Lockheed C130J → also turboprops 
o MD-Boeing C17 “Cargomaster” (PW engines) 
o Antonov An-124 (Lotarev D-18T engines) 
o Antonov An-22a (Soloviev NK-12 engines/open propellers) 
o Antonov An-225 (Lotarev D-18 engines) 
o Antonov An-72 (Lotarev D-36 engines) 
o Ilyushin Il-76TD (D-30KP engines) 
o SAAB 340 Cargo (CT7 engines) → also turboprops 
o Cessna Super Cargo Master 

• Business Jets [3] 
o Gulfstream G550 
o Dassault Falcon 2000 
o Cessna Citation Latitude 

• Military Aircraft (not disclosed) 
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MAIN MENU OPTIONS 

• Performance Charts 
o Aerodynamics 
o Specific Air Range 

 All Engines operating 
• Enter:  [Atmospheric temperature, winds, weight intervals] 

 One Engine inoperative 
• Enter:  [Atmospheric temperature, winds, weight intervals] 

 Centre of gravity effect 
o Engine Envelopes 

 Enter: [Mach number] 
o Flight Envelopes 
o Propeller 
o WAT (take-off) 

 Enter: [wind speed] 
 Change other default parameters:  

• [Runway condition, tyre slip ratio, runway gradient, flap, CG position] 
o Balanced Field Length  

 Single-point Balanced Field Length 
• Option to change the following: 

o [GTOW, runway conditions, tyre slip ratio, airfield altitude, 
winds, air temperature, runway gradient, flap setting, CG 
position] 

 Balanced Field Length charts 
o Payload-range 

 Enter: [cruise winds]  
o Economic Mach number 
o CG effects 
o Buffet Boundaries 
o Specific Excess Power 
o Go-Around Charts 

 Enter: [AUW, altitude AGL, flight path angle, wind, temperature, OEW] 
o Atmosphere-Speed Charts 

 Pressure-altitude versus geo-potential altitude 
 Altitude-TAS-CAS-Mach 

o Holding Charts 
 Enter: [Altitude, time, air temperature, GPS coordinates] 
 Enter: Flight into dust cloud or volcanic ash [Y/N] 

o Maximum Descent Rates 
o V-n Diagram 
o Climb Polar 
o Longitudinal Trim 
o Gust Response 
o Aircraft Volumes 

• Mission Analysis 
o Fuel Planning 

 Required range 
• Enter: [Origin/destination GPS coordinates; Required stage length] 

 Required bulk payload 
 Required passenger load 
 Atmospheric winds 
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• Cruise winds 
• Take-off & climb-out winds 
• Approach & landing winds 
• Change ATM Wind-speed profiles 

 Air temperature 
• Standard day, uniform deviation, arctic temperature model 

 Relative humidity 
 Aerodynamic deterioration 
 Engine deterioration 
 Other flight parameters (options) 

• Continuous descent approach 
• Perfect flight trajectory 
• Taxi-in time 
• Taxi-out time 
• Engine derating 
• Time delay for flap deployment 
• Final approach glide slope 
• Runway state (both take-off/landing) 
• Airfield altitude 
• Turn in climb-out 
• Flight level separation 
• Noise arrays extension 

o Aircraft Range 
 Passenger load (not available for cargo and drone-type aircraft) 
 Bulk load 
 Fuel load 

o Endurance 
 Passenger load (not available for cargo and drone-type aircraft) 
 Bulk load 
 Fuel load 

o Matrix Fuel-Plan 
o Equal-Time Point 

 → Same Options as Fuel Planning 
o Fly generic trajectory 

 Fly generic cruise trajectory 
 Fly into dust cloud/atmosphere 

• Parse DUST cloud file (see separate documentation) 
 ADS-B trajectory (see separate documentation) 

o Modify airplane configuration 
 

• Aircraft Noise 
o Take-off & Departure 
o Arrival & Landing 
o Arbitrary trajectory 

 Enter filename with trajectory data 
o Noise footprints 

 Take-off/departure  
• Select grid 

o Self-generated 
 Enter: [x-dimension; y-dimension; mesh resolution] 
 Ignore atmospheric winds: Yes/No 
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o Externally generated 
 Enter:  

• Trajectory file name 
• Ignore atmospheric winds: Yes/No 
• Ignore MIK outside build-up area: Yes/No 
• Restart footprint (if available): Yes/No 

 Arrival/landing 
• Select grid 

o Self-generated 
 Enter: [x-dimension; y-dimension; mesh resolution] 
 Ignore atmospheric winds: Yes/No 

o Externally generated 
 Enter 

• Trajectory file name 
• Ignore atmospheric winds: Yes/No 
• Ignore MIK outside build-up area: Yes/No 

 Departure + Landing 
 Ground properties 

• Enter option: [Snow, grass, Sand, Water, Tarmac/concrete] 
 Atmospheric turbulence properties 

• Enter Option: [Still air, moderately still, moderate, turbulent] 
 Post-Processing Operations 

• Difference between Noise Footprints 
• Translate Noise Footprint 

o Enter Longitudinal shift 
• Remove isolated points of “silence” 

o Stacking patterns 
 Footprint: Single take-off and landing 
 Footprint: Multiple take-offs and landings 

• Enter: [time separation between landings; 3D trajectories] 
• Output option: raw SPL [dB], OASPL [dBA] 

 Trajectory: Multiple flights 
• Enter: configuration filename 

o Directivity analysis 
 Enter: filename with case data 

o Options, Utilities and Defaults 
 Options include the following: 

• Parameter sensitivity analysis 
o Single-parameter perturbation 
o Multiple-parameter perturbation 

• Change ground-turbulence properties 
• Change Noise Propagation Model 
• Change sub-component noise models 

o Slats noise 
o Flaps noise 
o Jet noise 
o Wing/fuselage scattering (toggle) 

• Switch background noise 
o Single-value background dBA 
o Use default noise spectrum 
o Read noise spectrum from data file 
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• Switch APU noise 
• Switch Fan Liner Boundary Layer 
• Switch Noise Topography Effects 
• Switch Wing-Fuselage Noise Shielding 
• Switch Fan Temperature Control 
• Convert noise trajectory to 2D 
• Refine noise carpet/footprint 
• Reset Atmospheric Winds 
• Generate fly-over trajectory 
• Debug jet noise 

• Exhaust Emissions 
o Exhaust emissions versus range 

 Enter: [pax load, cruise winds, air temperature, bulk payload] 
o Emissions sensitivity analysis 

 Enter: [Required range, pax load, cruise winds, cruise temp, bulk load] 
 Options: ICAO Databank, Surrogate model, Own model 

o Taxi/ground roll emissions 
o Contrail analysis 

• Flight Optimisation 
o Minimum climb-fuel1 

 Enter: [En route flight distance; Flight level at terminal point] 
o Optimum climb between flight levels 

 Select weight intervals: [kilograms; pound-force] 
o Fuel tankering analysis 

 Enter: [same data as Fuel Planning; fuel price differential] 
• Manoeuvre Analysis 

o Landing in a downburst 
 Enter: [height of cloud base, downburst diameter, vertical speed] 

• Wind model output 
• Downburst flight path 

• Trim Analysis 
o Minimum control speed on the ground, VMCG 
o Minimum control speed in the air, VMCA2 

 
• Direct Operating Costs3 
• Utilities 

o Generate Unix “makefile” (Owner only) 
o Calculate distance between two GPS points (great circle distance) 

 Enter two points separated by blank space 

 

 

 
1 Solution may be impossible, depending on input data. 
2 Solution may be impossible; sensitive to aerodynamic derivatives. 
3 Uses default DOC database, which can be edited by user. 
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How to Calculate Taxi Emissions 
Calculation of engine emissions during taxi-out and –in, requires setting up a sequence of events, which 
include various combinations of acceleration, roll, braking, stopping/idle and turning. This is done with 
a configuration file shown below. 

# All lines starting with # are comment lines and are ignored on input  
# Taxi-schedule 
# This is a sequence of steps, with a category and a number which qualifies the step, as described 
 
  accelerate   5.0               ! accelerate to a final speed [m/s] 
  roll         0.5               ! roll at the specified speed for given distance [km] 
  idle         2.5               ! halt/stop for specified time [minutes] 
  accelerate   5.0               ! accelerate to a final speed [m/s] 
  roll         1.0               ! roll at the specified speed for given distance [km] 
  idle         1.0               ! halt/stop for specified time [minutes] 
  turn         180               ! total turn during taxi (no difference between left/right) 
   

 

The configuration file resides in the ./Data sub-folder. The procedure is as follows:  

Select: Airplane → Exhaust Emissions → Taxi/Ground Emissions 

Calculations are done automatically; the results are found in the file report_taxi_emissions.out. 

A typical report shows the data as in the table below. 

   TAXI EMISSIONS REPORT 
  --------------------------------------------------------------------------- 
           Segment      fuel[kg]   CO2[kg]   CO[g]   NOx[g]    HC[g]   soot[mg] 
     1   accelerate          4.1     13.1     0.00     0.00     0.00     0.04 
     2   roll               15.9     50.1     7.83     1.07     0.57     0.16 
     3   idle               41.4    130.7     0.47     0.06     0.03     0.41 
     4   accelerate          4.1     13.1     0.47     0.06     0.03     0.04 
     5   roll               31.7    100.2    15.66     2.15     1.14     0.32 
     6   idle               16.6     52.3     0.19     0.03     0.01     0.17 
     7   turn               16.8     53.1     0.10     0.09     0.00     0.17 
  --------------------------------------------------------------------------- 
         TOTAL             130.7    412.5    24.71     3.47     1.80     1.31 
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How to Calculate Direct Operating Costs (DOC) 

Calculation of direct operating costs relies on a large number of assumptions about present and future 
costs, often in an uncertain environment that requires long-term forecasting. Inevitably, the results 
depend on how good these assumptions on future costs are.  
FLIGHT can handle several assumptions, which are found in a configuration file that resides in the 
./Airplanes/airplane_name sub-folder. 

"Prepared by A. Filippone, on 8 June 2014; Project = A321-200 DOC     ! don't forget title 
 
"A321"              airplane name 
 
"Dollars"           currency                                       (data below are in Dollars) 
 
 44d6               aircraft_price                                 (in above currency) 
 
 0.67               fuel price_now (fuel price TODAY)              (per kg) 
  2.0               fuel_price_inflation                           (% per year, AVERAGE) 
  25.0              fuel_price hike on specified year *OIL SHOCK*  (%) 
  2                 year at which OIL SHOCK is expected  
  1.2               insurance, based on aircraft actual value      (% per year) 
 
 100.               spares_price1 (airframe, landing gear, tyres)  (per flight hour, year 1) 
 200.               spares_price2 (engine, APU, lubricants):       (per flight hour, year 1) 
  70.               spares_price3 (avionics/systems/pax_services)  (per flight hour)   
 
   25.              life_time                                         
   85.              depreciation over life-time                    (% of initial cost) 
   70.              financing                                      (% of initial cost) 
   4.5              interest rate                                  (%) 
   15               years of mortgage (integer number) 
 
58000.              crew_price1, pilots                            (full time/pilot/year) 
27000.              crew_price2, flight attendants                 (full time/staff/year) 
   2.              crew_price_inflation                           (%); set 0 if prices are not updated 
   80.              off_station_price (hotels, etc)                (per person/night) 
 
   60.              labour_rate1, power plant                      (man-hour) 
   35.              labour_rate2, in-house maintainance            (man-hour) 
   50.              labour_rate3, contracted out                   (man-hour) 
 
  0.5               man_hour1, powerplant                          (per flight hour) 
  0.5               man_hour2, in-house                            (per flight hour) 
  0.5               man_hour3, contracted out                      (per flight hour) 
 
 1000.              landing_charges, airport fees                  (per movement) 
  200.              ground handling costs                          (per movement) 
    1d4             recurrent training_costs                       (per pilot/year) 
   12.              flight service costs: catering, marketing      (per pax per movement, on YEAR 1) 
    0.              ground service costs: hangars and others       (per year)  SEE NOTE [k] below 
 
 1200               cycles                                        (number of cycles/year; even number) 
 
"international"      service_type                                   ALTERNATIVES: SEE NOTE [h] below 
 .true.              overrides "cycles" if true; keep above value if .false. 
 
 1200.               stage length, n-miles                          (average) 
   87.               average load_factor  (pax/seats) 
 
 12000.              fuel burn in full mission                      (kg)  ** PREVIOUSLY CALCULATED ** 
  170.               block time                                     (min) ** PREVIOUSLY CALCULATED ** 
 
 1000.               cargo/freight                                  (kg/flight)  , SEE NOTE [j] below 
   5.25              cargo_price                                    (currency/kg) 
   1.0               other_cost (any other costs not included above) (per flight) 
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1. TECHNICAL NOTES 
#---------------------------------------------------------------------------- 
  Requires about 40 entries. 
 
  2. ASSUMPTIONS 
#---------------------------------------------------------------------------- 
  a. man_hour    inflation is the same as "crew_price_inflation" 
  b. labour_rate inflation is the same as "crew_price_inflation" 
  c. all other costs (spare parts, etc.) are inflated by the same amount 
  d. if no OIL SHOCK is expected, assume 1.0; the year (next record) will be ignored 
  e. number of cycles is tentative; FLIGHT will make a better estimate; may override data above 
  f. if you change the stage length and/or the bulk cargo, you must repeat mission calculation, 
     because fuel burn and block time will be different 
  g. the override parameter must be .true. or .false. Error is encountered otherwise.; this parameter 
     is overridden if the number of cycles is not achievable. 
  h: commuter service (X < 250 nmiles); international (250 < X < 2500); intercontinental (X > 2500) 
  k: ground handling costs may include hangar rental, deicing services. 
  j: if airplane operates cargo, it is likely that you need to increase ground handling charges 
  i: any other costs not previously included, inc. navigation costs, damage repairs, etc. 
 
  3. WARNINGS 
#---------------------------------------------------------------------------- 
  Program does not verify these numerical data, except the number of cycles 
  required for stage length, block time and any negative entry; all data 
  must be consistent and reasonable.  
 
  DO NOT swap lines: The program will not understand it. 
  
  If something is wrong on input, the program will report the line number relative 
  to the last record read successfully. For example if last_record = currency, 
  there must be something wrong in the "aircraft_price" data (one line below). 
 
  The program cannot be responsible for silly entries. 
  

 

There are two lines denoted with ** PREVIOUSLY CALCULATED **. This means that a mission analysis 
must be run on the average mission scenario, to produce two data: mission fuel burn and block time. 
Without these figures, the operation cannot be completed. See the note on how to set-up a Mission 
Analysis. 

Once the configuration file is prepared, select Airplane → Direct Operating Costs. 
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How to Create a Sub-zone for Noise Mapping 

• Parse original map with Map-Tool and visualise output file “map_raw.out” with Tecplot. 
• Within Tecplot select “Tool to Probe Data”: probe corners of quadrilateral shape.4 

o Keep note of the indices (I, J) in the Zone/Cell Info box 
• Within Tecplot select: Data → Extract → Sub-zone and create Sub-zone. 

o Visualise Sub-zone until content (various sub-zones may have to be generated). 
• When content, within Tecplot select: File → Write Data File 

o Write sub-zone file with: Format = ASCII, Zone Format = Point, Precision = 4 
o This sub-zone must have 5 variables: x, y, z, at, RGB 
o Convert this file to readable Tecplot file by updating the default headers5. 

• Exit Tecplot and run Map-Tool after preparing the maptool.cfg file as described below.  

“LCY_subzone.dat"             ! sub-zone file name 
 .true.                       ! write Tecplot file for visualisation (output cannot be used for noise) 
 .true.                       ! synchronise map to trajectory 
 .true.                       ! swap travel direction (for example East -> West becomes West -> East) 
"iface_noise_landing_E195.out"! trajectory file, which must be placed in the ./Trajectories sub-folder 
  28.0                        ! estimated CPU time required to calculate this noise trajectory [s] 
 8712.   0.                   ! touch-down or brake-release point on TRAJECTORY [m] 
 14970.  2570.                ! touch-down or brake-release point on MAP   [m] 
  1   1                       ! grid level/resolution in x,y (1 = as it is; 2 = half resolution) 
  10  10                      ! grid resolution [m]: IGNORED when dx < 30 m, dy < 30 m 

 
How to Create/Update maptool.cfg File 
1. Sub-zone file name: must be meaningful; use the IATA airport code, in this case London City. 
2. Write Tecplot file to visualise both sub-zone and trajectory position. 
3. Synchronise sub-zone map to trajectory. 
4. Swap travel direction. This is tricky and must be fully tested – not fool-proof. 
5. Choose trajectory file name in ./Trajectories sub-folder. 
6. Estimate CPU time to run noise analysis for single microphone (strictly not necessary here). 
7. Calculate coordinates of touch-down or brake-release point from noise trajectory. 
8. Calculate/estimate coordinates of touch-down or brake-release point on the raw map: this is the 

same point on the sub-zone! 
9. Set grid level resolution to 1  1 (integer numbers separated by a blank space). 
10. Set cell resolution to very low number, so this command will be ignored (see comment above). 

 
• After running Map-Tool, proceed to Tecplot visualisation of new map and trajectory. These files 

are called map_parsed.out and trajectory.dat 
• If satisfied with the map, run the Map-Tool again with the Tecplot-flag = false, to generate the 

output files needed by the FLIGHT code. 
• Map-Tool generates a number of partitions of this sub-zone. 

 
An example of sub-zoning is shown in Figure 1 for London City airport. The case refers to an Embraer 
E195 landing on runway 27 (e.g. westbound), and the sub-zone is North of the airfield, roughly located 
between Royal Albert Way to the South and the A13 to the North (the area is known as Beckton), for 
about 4 km alongside the runway. Each colour on the map denotes a specific value of the ground 
impedance. 

 
4 In the future it is expected to be able to generate sub-zones of more general shapes. 
5 The file printed out has Tecplot headers that cannot be parsed by Map-Tool. 
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Figure 1: Sub-zone (in blue) selected for noise footprint analysis, at London City (IATA: LCY). 

 

Use of the Topography Noise Corrections 

A reasonable airfield map will have cells with dimensions 30m x 30m, approximate. A lower resolution 
is not currently achievable. Most likely, the resolution will be around 40m x 50m. Within each cell, it is 
not possible to discern differences in elevation, topographical details, etc. Therefore, each grid cell is 
associated to a fixed identity and ground impedance. Some topographical corrections to noise 
propagation are possible in a few instances, for example shielding offered by trees, forested areas, 
dense foliage, tall grass and (virtually) infinite barriers. This can be done by toggling the noise-
topography option in the Noise Sub-Menu. 
 
In Figure 2 we show an impedance model of the airfield. Each cell is flooded with a constant-value 
impedance; B denotes the reflection point of an acoustic wave eventually reaching a receiver R. The 
path B-C, traced on the ground, crosses through cells of fixed identity. If, for example, there are tall 
trees denoted by the darkest shade, the line of sight of the acoustic wave is impeded when travelling 
through the segments a, b, and c. These segments are calculated and correction to ground noise 
propagation, depending on frequency, is added to the signal reaching the receiver R. Likewise for other 
segments that cross through different ground properties. In practice the reflection point is close to the 
receiver, possibly within one grid cell, unless the airplane is very close to the ground. 
  

 
Figure 2: Detail of an airfield model, coloured by ground type, or impedance value. 
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How to Restart a Footprint Analysis 

Noise footprint calculations are computationally very demanding. As a rule of thumb, we have: 

• Twin-engine turbofan airplane: 25-30 s/grid point, depending on hardware platform 
• Four-engine turbofan airplane: 30-35 s/grid point, depending on hardware platform 
• Turboprop airplane, 2-3 minutes/grid point 

The turboprop airplane case has not been numerically optimised, something that will be done in the 
future, with the goal of reducing the computing time to a similar value to that of the turbofan airplane.  

The data indicated refer to absence of winds. The presence of strong winds, especially if sideways, 
increases enormously these computing times, and general guidance cannot be given in this instance. 

Restart Procedure 

If the job has been killed before completion, it can be restarted following the same steps. The program 
is able to identify the existence of a footprint output in the working folder and asks the user whether to 
restart or not. In the affirmative, the data are appended to the existing file and restarting is done from 
the last grid point, identified automatically. In the other case, the existing footprint output file is 
overwritten and computations start afresh.  

The user can see where the computations have been restarted, since at each restart the code prints out 
a comment line such as this: 

#------- Restarting from grid point 159  on 11 August 2015; time 9:15 

Note: the restart file must be in the working folder! – No checks are made to verify that the existing file 
is consistent with the new inputs and requirements. 

Noise Footprint Output File 

The output file contains data that depend on many parameters. Unless all the metadata are specified, it 
is impossible to replicate the results or even understand under which conditions the results have been 
obtained. For this purpose, the top of the noise footprint file contains several metadata, as shown 
below. 

 
title = "Embraer_E195-ST; Engine CF34-10E7 ; generated by FLIGHT V. 7.8.3 ; Database V. 21.3.0" 
# METADATA: Mass[kg] = 42371; Vw[kt] = 0 (ignored); RH[%] = 70; dTemp [K] = 0; Noise propag. = Rasmussen 
# METADATA: Background noise = false; Wing-Fuse shield = false; Fan-Liner B.L. = false; APU = on  
# METADATA: Ground = Mixed impedance; Airfield topography effects = true  
# METADATA: Flight procedure = Unspecified 
# METADATA: Airport (Trajectory) = LCY 
# METADATA: Airfield area =  34.207 [km^2] 
# METADATA: All noise in [dB], except PNL[dBA], LA[dBA] 
# METADATA: Job started on 11 August 2015; 9:56 
# METADATA: Computer platform is Windows 
 
 

CAUTION 

RESTART must be used with extreme caution when the grid is self-generated. For example, at the first restart the 
existing grid characteristics are not checked; it is possible that the new grid is different, in which case the 
restarted calculations are unlikely to make any sense. 
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How to Run a Noise Sensitivity Analysis 

Calculation of the aircraft noise along a specified trajectory depends on a large number of parameters 
whose exact value is unknown. More precisely, there are known and unknown parameters which may 
or may not affect the noise prediction at the reference microphone position. These parameters are 
classified according to their origin, as follows: 

• Engine aero-thermodynamic parameters 
• Airframe parameters (geometry/configuration) 
• Propeller geometrical parameters and operation point 
• Airplane position with respect to the reference microphone 
• Atmospheric conditions 
• Ground properties 
• Program/software options 

FLIGHT calculates the noise sensitivities in three ways: 

1. By adding 2dB to all noise components; this is reflected in the final noise metrics, and appears 
in the output file “report_noise*.out”. 

2. By adding a single perturbation at a time to a number of parameters specified by a 
configuration file (described separately). Perturbations are assigned in the noise sensitivity 
configuration file. 

3. By adding multiple random perturbations at a time to a number of hard-coded system 
parameters, in the categories listed above (described separately). The noise sensitivity 
configuration file is ignored in this case. 
 

In the latter two cases, FLIGHT produces an output file (noise_sensitivity_matrix.out) that contains the 
noise metrics corresponding to each perturbation, the overall statistics and in the latter case also the 
list of perturbed parameters. The first option is only indicative of how much the final EPNL changes due 
to an uncertainty on each single noise component; this perturbation is not associated to any specific 
element on the airplane, or external to the airplane. 
 

Single-Perturbation Analysis 
 
One parameter at a time is subject to a random perturbation specified by a maximum amplitude found 
in the sensitivity configuration file (./Airplanes/airplane_name/..), an example of which is shown in 
Table 1 at the end of this document. 
 

Multiple-Perturbations Analysis 
 

Several parameters at a time are subject to a random perturbation specified with the program – there 
is no opportunity to change data here. The perturbation module constructs a vector 𝑽𝑽 = (𝑑𝑑𝑑𝑑… ) of 
parameters, which at the end of the noise computations is restored to its initial (default) value; then, 
another iteration is carried out. An example of output is shown in Table 2. The moments of the 
distribution are: average, mean value, standard deviation and curtosis. 
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Table 1: Configuration file for noise sensitivity analysis, with single-perturbation strategy 
# Flight V.6.3.3: noise sensitivity database 
 
"Engine"    3                          ! category; number of active components to read  
 
   "FAN"    5                          ! component; number of sub-components to read 
 
   "nb_fan_vanes"             0.0      ! change in fan vanes number, % uncertainty;  * NO EFFECT FOUND * 
   "TT2_2"                    2.5      ! discharge side fan temperature, % uncertainty 
   "W1"                       5.0      ! mass flow rate, uncertainty, % uncertainty 
   "N1"                       5.0      ! fan rpm, uncertainty, % uncertainty 
   "xduct"                   12.0      ! length of acoustic liners duct (inlet/discharge), % uncertainty 
 
 "JET"      6                          ! component 
   "core_nozzle_area"        10.0 
   "bypass_nozzle_area"      10.0  
   "core_plug_length"        10.0   
   "bypass_plug_length"      10.0                       
   "TS9"                      3.0      ! relative change in exit/nozzle temperature, percent 
   "Mach9"                    5.0      ! change in exit/nozzle Mach number, percent 
 
 "COMB"     2                          ! component 
   "Wf6"                      3.0 
   "TT4"                      3.0 
 
 "TURBINE"  1 
   "nb_TRB_LP"                0.0      ! number of turbine blades, % uncertainty; ** NO EFFECT ** 
 
"Airframe"  4                          ! category, and number of components 
  
  "MLG"     2                          ! component with two sub-components; records to read 
 
   "main_strut_width_avg"    12.0      ! change in total strut width, percent 
   "main_strut_length_all"   12.0      ! change in average strut length, percent 
      
  "NLG"     2                          ! component with 2 sub-components; records to read  
 
   "nose_strut_length_all"   12.0      
   "nose_strut_width_avg"    12.0  
 
  "FLAP"    2                          ! component 
 
   "flap_area_in"            12.0      ! change in inboard flap area, percent 
   "flap_area_out"           12.0      ! change in outboard flap area, percent 
 
 
  "SLAT"    2                          ! component 
 
   "slat_area_in"             0.0      ! uncertainty, inboard flap area 
   "slat_area_out"            0.0      ! uncertainty, outboard flap area 
 
 "Ground"     1                        ! category, including ground properties 
 
  "REFLECTION" 4 
   "sigmae"                  50.0      ! flow resistivity 
   "alpha_gr"                 0.0      ! effective depth (not very effective parameter) 
   "mu2"                    100.0      ! fluctuating index of refraction  
   "backg"                    0.0      ! account for standard background noise; value is ignored 
  
 "Atmosphere"   1                      ! category 
 
  "PROPAGATION" 4 
     "dTemp"                 10.0      ! change in temperature 
     "RH"                     5.0      ! change in relative humidity, percent 
     "dWind"                  2.0      ! change in wind speed, absolute value, direction: 0 degrees 
     "dWindDir"               0.0      ! change in wind direction, absolute value (degrees) 
 
 "Trajectory"   3                      ! category 
     "SHIFT"    3 
      "dx"                   25.0      ! absolute distance in [metres]            
      "dy"                    8.5      ! absolute distance in [metres], 1/4 wing span 
      "dz"                    2.0      ! flight altitude in [metres] 
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Table 2: Result of multiple-perturbations noise sensitivity 
 
 variables = "id"   "EPNL"    "SEL"   "PNLTM"   "LAeqT"    "LAmax"  "SPLmax" 
              1    98.677    93.718   105.958    74.876    91.104    92.911 
  
              2    99.739    95.165   106.444    76.128    91.792    93.687 
              3   101.471    96.070   109.105    76.995    93.828    95.450 
              4    98.255    94.597   104.834    75.628    90.957    92.899 
              5    96.895    90.975   103.187    71.952    87.038    89.441 
              6    99.609    94.209   106.831    75.158    91.417    93.224 
              7    95.211    90.536   100.904    71.456    85.756    88.237 
              8    98.225    93.799   105.037    74.815    90.831    92.802 
              9    98.985    94.004   105.688    75.103    90.571    92.437 
             10    96.419    91.305   101.958    72.186    86.871    89.358 
 
   Statistics over10 sample points, One Microphone 
  ------------------------------------------------------- 
    Mic    Metrics     ave      adev      sdev      var   
     1      EPNL    98.349    1.3475    1.8100    3.2762 
     1       SEL    93.438    1.4994    1.8682    3.4901 
     1     LAeqT    74.430    1.5391    1.8930    3.5833 
     1     PNLTM   104.995    1.8189    2.4271    5.8909 
     1     LAmax    90.016    2.0770    2.5734    6.6225 
     1    SPLmax    92.045    1.8195    2.2702    5.1538 
  
   List of Perturbed System Parameters 
  ------------------------------------------------------- 
     1   Engine: W1 (mass flow) 
     2   Engine: Wf6 (fuel flow) 
     3   Engine: N1% (speed) 
     4   Engine: TS9 (static nozzle T) 
     5   Engine: TT2_2 (fan exit total temp) 
     6   Airframe: MLG strut length (all) 
     7   Airframe: MLG strut with (avg) 
     8   Airframe: NLG strut length (all) 
     9   Airframe: NLG strut width (avg) 
    10   Airframe: core nozzle area 
    11   Airframe: outboard flap area 
    12   Airframe: inboard flap area 
    13   Position: change x-coordinate 
    14   Position: change y-coordinate 
    15   Position: change z-microphone 
    16   Atmosphere: relative humidity 
    17   Atmosphere: air temperature 
    18   Ground: flow resistivity 
    19   Code options: Fan liner boundary Layer 
 
 

How to Create to Operate on Different Noise Footprints 

Occasionally, it is useful to carry out operations with noise footprints, as previously calculated, to 
understand the effects of some operational parameters and/or numerical models. For this purpose, it is 
necessary to have two files having the same grid dimensions (nx,ny), otherwise the comparison 
becomes more complicated. There are two ways to proceed.  

The first is to use a tool within FLIGHT that calculates differences and averages between noise metrics, 
as well as shifts of the noise metrics along the flight direction.  

• Select: Aircraft Noise → Noise Footprints → Noise Operations 
• For Differences/Averages between noise footprints, select the appropriate option 
• FLIGHT produces two output files: “footprint_average.out”, “footprint_difference.out” 
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Note that the user is required to type two file names. The differences are calculated between the 
second file and the first file.  

The code attempts to make some preliminary checks on the input files, such as grid size (nx,ny), grid 
dimensions (dx, dy), location of minimum points (xmin, ymin), number of variables available in the input 
files (nvarf). If in any of these instances there is a mismatch, the program will stop. Differences and 
averages are calculated for each noise metric. Differences > 99 are automatically set to zero. 

The code will stop if a “restart” command line is found. Such line must be removed. 

Another way of analysing different noise footprints is within Tecplot 

• Within Tecplot, load Multiple Files (which must be consistent as described above). 
• Within Tecplot select: Data → Alter → Specify Equations. 
• Define a new variable: if the data files have n variables, you need to define variable n+1. If a 

difference between variables Vi is required, then the equation is  
o V(n+1) = Vi[2] – Vi[1]       
o Note: V(n+1) is difference of variable Vi on 2nd file and Vi on 1st file loaded 

• Now plot contours with V(n+1) as field variable, Figure 1. 
• The new variable can be renamed in dialog box: Data → Data Set Info → Zone/Variable Info 
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How to Calculate Multiple Noise Trajectories 

Multiple aircraft operations at an airfield can be calculated with a specific option. Select 

Aircraft Noise → Noise Stacks → Trajectory: Multiple Operations 

This operation requires a configuration file, which contains the following data: 

“Flight_trajectory_file_name”          “operation”     time_delay 

The trajectory files must be in the working folder. 

Compliance 

The operation data is either “landing” or “takeoff”. The time delay is a numerical value, in seconds, 
specifying the time sequence of the various flights. It is not advisable to mix arrival and departures, 
since   

This configuration file is to execute aircraft noise calculations for multiple operations for the SAME 
AIRPLANE.  

The code will simulate aircraft noise at microphones specified in each trajectory. If microphones have 
different positions, or if the number of microphones is different, then the results are unpredictable. ALL 
files must have the same microphones. In summary, we must comply with the following conditions: 

• Only one airplane type is possible. 
• Trajectories must be calculated with respect to a common reference system on the ground. 
• The microphone positions must be the same for all trajectories. 
• The time gap between trajectories must be reasonable (60 to 180 seconds). 

Outputs 

The results are printed into two different files: 

1. “cost_function.dat” which contains two parts: 1.) noise metrics; 2.) exhaust emissions. 
 

2. “noise_multi_flight.out” which contains the time-dependent noise metrics OASPL (overall sound 
pressure level), OASPLf (airframe noise), OASLPe (propulsion noise), OASPLc (engine core noise), 
PNL (perceived noise level), PNLT (perceived noise level, tone-corrected), LAdBA (A-weighted 
overall sound pressure level). 

 

Caveats 

It is unlikely that the integral noise metrics (EPNL, SEL, LAeqT) are reliable, because if the time 
separation between flights is sufficiently large, then there will be separate noise peaks, which have 
their own integral characteristics. 

The instantaneous noise metrics may have wild oscillations within the overlapping flight time. 
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How to Use GPS coordinates in Flight Planning 

In the fuel mission analysis, the required range can be entered as a distance (in km) or as a double pair 
of GPS coordinates (latitude, longitude). In the latter case, the code calculates the distance between the 
two GPS coordinates, along a great circle, and performs a calculation of fuel planning along this 
trajectory. Note that occasionally, the actual distance travelled is longer than the great-circle distance. 

Example: A flight from London Heathrow (LHR = 51.4775, -0.4610) to Doha (DOH = 25.2729, 50.6084) 
yields a great circle distance of about 2,810 nautical miles. On final approach, it is possible that the GPS 
coordinates are not updated, because of the larger distance travelled.  

Go to: Mission Analysis → Fuel Planning → Required Range → Origin/Destination GPS Coordinates 
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